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	 Basics of Information Technology

Unsolved Exercise
Part A 

A. 	 1.	 Data	 2.	 Platter	 3.	 Kernel	 4.	 Nibble	 5.	 Pixels	 6.	 MHz
B. 	 1.	 i	 2.	 iv	 3.	 iii
C. 	 1.	 Douglas Engelbart	 2.	 nine	 3.	 120 mm	
	 4.	 Arithmetic Logic Unit, Control Unit,  Memory Unit	 5.	 Magnetic

Part B
A. 	 1.	 i.	 Mobile Application: Mobile Application is commonly known as Mobile App. It was 

introduced by Apple for its mobile phones. Mobile application is specifically meant for 
use on handheld wireless computing devices such as smartphones and tablets. Mobile 
App is OS specific, i.e., Android, Apple, etc. It will work only with particular mobile for 
which it has been developed.

		  ii.	 Kernel: Kernel is the core part of an OS, that does all the major activities (such as memory 
allocation, CPU time, scheduling, etc.) for the operating system.

			   Kernel helps in initialization (booting) function, such as checking memory. It allocates 
and de-allocates memory space which allows software to run. 

		  iii.	 File system: Operating System facilitates for proper file system that helps to organize 
and obtain grouped information or execution from a data storage device in a systematic 
manner, i.e., ‘File System’ is the basic structure and concise format to arrange the set of 
information with their names.

		  iv.	 Device Driver: A device driver is a form of software that enables a hardware device to 
be compatible with the computer. It activates the specific hardware device that can be 
easily interpreted by the CPU resources. Device drivers are operating system specific 
and hardware dependent computer programs, which may automatically get activated 
whenever that hardware device is attached to the computer.

		  v.	 Biometric Devices: These devices use the physical characteristics of a living being to 
authenticate its identity. These devices are capable of scanning hand prints, finger prints, 
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retinal information, facial features etc. to compare with a sample and grant access to 
an individual to a particular device or information. Example: Used in phones for security 
and used for attendance tracking in offices.

		  vi.	 Barcode: A Bar Code Reader is a popular scanning device which reads the bar codes. 
Bar code comprises of adjacent vertical black bars of different width. A barcode stores 
information about a product, eg: its price, weight, manufacturing details etc. Bars are 
code that represent different numbers.

		  vii.	 Chat Sites: Chat Sites is a feature of Internet that enables instantaneous transmission of 
messages from the sender to receiver on Internet. Many chat applications enable transfer 
of audio chat, video calling, sharing desktops, etc. apart from the standard text chat. 
Chatting is widely used for the personal as well as commercial use. Unlike email, chatting 
takes place in real-time and the response from the participants are spontaneous. If the 
receiver is online, message is received concurrently while it is sent.

		  viii.	Social Network: Social network refers to a network of several people interacting through 
computing device around the world on the internet. It is the network of people who 
form communities among themselves to share sentiments, relationships, ideas, topics 
of common interest, etc. These people may be linked to each other because of some 
common association or a platform (like, students of same school, member of same club, 
associate of same trade, etc.), that they may have shared in the past or are planning to 
join in future.

	 2.	 i.	 New Technology File system
		  ii.	 Light Emitting Diode
		  iii.	 Magnetic Ink Character Recognition
		  iv.	 Power on Self Test
		  v.	 Computer-aided Design
		  vi.	 Desktop Publishing
		  vii.	 Extended File System
		  viii.	File Allocation Table
		  ix.	 Wireless Fidelity
		  x.	 Worldwide Interoperability for Microwave Access
		  xi.	 Radio Frequency
	 3.	 BIOS is stored in ROM and it operates when the computer is switched ‘ON’. It contains a 

set of essential softwares that test the setup of hardware devices during startup. It helps to 
start the operating system and supports the transfer of data among the hardware devices.

	 4.	 Radiowave, Microwave, Infrared
	 5.	 No, A computer is an instruction driven device that accepts data, processes it and produces 

the desired results in the form of information.
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	 6. 	 RAM is a volatile memory i.e. when a computer is switched ‘OFF’ or the power supply is 
interrupted, all the information stored in it gets disappeared or lost.

	 7.	 Cache Memory is a part of CPU and is used when there is swapping of information between 
the primary memory and the ALU.

	 8. 	 An antivirus is a utility software that helps the computer to be free from virus. Moreover, 
it notifies when any program gets infected and contaminate other files. In addition, it also 
scans the computer and provides protection against malware. It also scans the system in real 
time for any threats and eliminate them. Examples of antivirus software are McAfee, Quick 
Heal, Avast, etc.

	 9.	 i.	 Impact printer prints the contents by striking the printer head or needle on an ink ribbon 
which rolls through the cartridge to make a mark on the paper.

			   Non-Impact printer prints the output without touching or striking the ribbon on paper 
or on the film. This kind of printer prints by using thermal, chemical, electrostatic, laser 
beam or inkjet technology. Usually non-impact printer has a greater resolution and is 
faster as compared to impact printer.

		  ii.	 It is a wireless connectivity that takes place through radiowaves. It enables to exchange 
information between devices like mobile phones, laptops, personal computers, printers, 
etc. over a private short range network. The network connection takes place through 
bluetooth dongle or inbuilt bluetooth transmitter present in the mobile or other computer 
devices. The connectivity through bluetooth consumes less power, and consists of  
low-cost transceiver microchips.

			   Wi-Fi (Wireless Fidelity) is a network of wireless connection that takes place through 
radio frequency(RF). Wi- Fi uses the same radio frequency as Bluetooth, but with more 
power, resulting into a stronger connection.

			   Wi-Fi is sometimes called ‘Wireless Ethernet’. Wi-Fi is supported by many applications 
and electronic gadgets including video game consoles, home networks, PDAs, tablets, 
mobile phones, I-Pad, I-Pod, etc.

		  iii.	 The physical components, which can be touched or felt are called the hardware 
components, whereas the components which cannot be touched or felt, such as 
instructions, data etc. form the software component of the system. Keyboard, Mouse 
etc. are hardware & MS Word, Windows etc. are software.

		  iv.	 It holds the information temporarily, during the ongoing operation of a computer. When 
a computer is under operation, the data or instructions come into its memory for instant 
access from the secondary memory. During the course of the execution of instructions, 
some intermediate results may be produced which are stored in the RAM.

			   It stores a set of pre-defined instructions for the internal operations of a computer. It is 
also referred as ‘non-volatile’ memory or ‘firmware’. 

			   Once the user switches ‘ON’ the computer, the computer automatically does a series of 
sequential tasks like POST (Power On Self Test), RAM Test, etc. before the user starts his work.
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B. 	 1.	 The functional elements of a CPU can be divided into three parts:
	 	 •	 Arithmetic Logic Unit (ALU)
	 	 •	 Control Unit (CU)
	 	 •	 Memory Unit (MU)
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	 	 •	 Arithmetic Logic Unit (ALU): An ALU performs mathematical calculations (addition, 
ubtraction, multiplication, division, etc.) and logical comparisons (greater than(>), less 
than(<), equal to (=), not equal to(!=), etc.). ‘Logical Operation’ refers to a comparison 
between two phrases that results in ‘TRUE’ or ‘FALSE’ value. It receives the coded data 
and manipulates them to produce information in machine code and then send to the 
Control Unit. 

	 	 •	 Control Unit (CU): A control unit co-ordinates and directs the operation of the hardware 
devices. It also co-ordinates the flow and execution of the data and instructions, that 
are fed into the computer’s memory. CU functions in a F-D-E-S (Fetch-Decode-Execute-
Store) cycle. It fetches the instruction and data from the memory unit & decodes them 
and passes to the ALU for further processing. It also directs the ALU to execute the 
instructions and performs the required operations on the data. 

	 	 •	 Memory Unit (MU): A memory unit or main storage or the internal storage stores the 
data, instructions, intermediate and the final results that are ready for the output. All 
instructions or data are stored in the memory unit before being used by the ALU or the CU. 

	 2.	 A set of organized programs meant for specific purpose is known as ‘Software’. Software is 
an intangible part of a computer which provides intelligence to the computer. Software can 
be broadly classified as:

	 	 •	 Application Software
	 	 •	 System Software
		  Application Software: Application Software refers to programs which are designed to 

accomplish particular type of tasks to meet a user’s specific needs. Application software can 
be classified into two categories: 

	 	 •	 General Purpose Application Package 
	 	 •	 Specific Purpose Application Package
	 	 •	 Customised Package
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		  An application software enables a user to manage his/her specific type of task easily and 
properly. This type of program is specifically developed for the users who want to automate 
their work and generate reports as per the need. It is also called customized software or tailor 
made software. For example: Accounting management system, reservation system, payroll 
system, inventory control system, billing system, etc.

		  Software which is designed especially for a specific purpose to fulfill, the requirement of a 
particular individual or an organization is called a ‘Customised Software’. It is also called a 
‘Tailor Made software’. For example: Inventory Management System, Fee collection system, 
etc. It is developed according to the personal need of a user.

	 3.	 Network refers to an inter-connected group of people, object, companies, computers, etc. 
For example, interconnected telephones create telephone network. A computer network is 
a link between two or more computers that are connected for the purpose of sharing of 
information and resources among themselves.

		  Advantages of Networking: 
	 	 •	 Sharing of files: Networking is an effective way of sharing files among different nodes 

(connected computer). For example, in a school, if the result file is there on a network 
system, then the examination department, the Class teachers, the Principal; all can share 
and access the data of the same result file from their own systems (i.e., nodes). 

	 	 •	 Sharing of Resources: Networking helps in sharing of common hardware devices. For 
example, a printer can be connected to a computer in a network that can be shared by 
different nodes which are connected within the same network. 

	 	 •	 Delivery of Information: Networking helps in quick delivery of information. In 
conventional system, sending letter from one place to another takes several days but 
one can send the same letter or other files instantly through a network. 

	 	 •	 Low cost of data transfer: With the help of a network, data or information gets 
transferred at a very low cost. Networking has considerably reduced the cost of transfer 
of information from one node to another.

	 4.	 A computer is a wonderful electronic machine and it has many significant features which 
make it a multipurpose device. The special characteristics that make it such a popular and 
useful machine are:

	 	 •	 Speed: A computer works at a very high speed. It can execute millions of instructions in a 
second. Its speed is measured in Hertz i.e., Hz (KHz, MHz, GHz, etc.). A modern computer 
can perform calculations in ‘Nano Second’ or ‘Pico Second’.

	 	 •	 Accuracy: A computer performs its tasks accurately. It performs calculations without 
making mistakes and produces information in accordance to the data entered.

	 	 •	 Reliability: A computer is a reliable device, it does not fail to produce accurate results. It 
works exactly as per the given instructions. It can even work in severe conditions, where 
human beings cannot work.
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	 	 •	 Versatility: A computer is versatile in nature i.e., it can work on various kinds of inputs 
and can produce multiple kinds of outputs like sounds, graphics, texts, animations, etc. 
It is a single machine capable of performing hundreds of different tasks.

	 	 •	 Storage Capacity: A computer has a very huge memory. It can store large volumes of 
data in a small sized hardware device, which can be retrieved as and when required. The 
unit of storage of data is known as Byte. 

	 	 •	 Diligence: A computer is free from problems such as tiredness, monotony or lack of 
concentration that humans face. It can work for many hours at a stretch. It can perform the 
same task repeatedly on a similar or dissimilar data without any error, tiredness or boredom. 

	 	 •	 Logical Ability: A computer is capable of comparing all types of data, like numeric or 
non-numeric and it can even take logical decisions as per the given instructions. 	

	 	 •	 Flexibility/Multitasking: During its operation, a computer can perform multiple tasks at 
the same time. It allows the user to switch from one application to another at any point 
of time. 

	 	 •	 Transfer of Data: We can also transfer data from one computer to another through 
external storage devices like Pen Drive, CD, DVD, Blu-ray disc or via networks.

	 5.	 It includes communication that takes place with the help of a solid or wired medium like:
	 	 •	 Ethernet Cable: Ethernet is a data link technology for local area network. It was invented 

by an electrical engineer named ‘Robert Metcalfe’ from United States. Ethernet cable 
refers to CAT5, CAT6 cable which is connected to an Ethernet card to a computer

	 	 •	 Co-axial Cable: It consists of a single conductor surrounded by a circular insulation 
layer and a conductive shield. Such cables have a transmission rate of 100 Mbps with a 
bandwidth up to 400 Mhz.

	 	 •	 Fiber Optics: This type of cable is used mainly in larger networks in which the data are 
transferred through electromagnetic waves. One fiber of such cable can support over 
30,000 telephone lines at a time.

	 6.	 Components of Multimedia are:
	 	 •	 Text: It refers to contents that can be read or typed on the screen.
	 	 •	 Audio: It includes speech, audio effects, ambient sound and music.
	 	 •	 Video: It includes images moving at a specific rate with some audio.
	 	 •	 Graphics: It includes drawings, paintings, scanned images, photographs and video.
	 	 •	 Animation: It refers to display of images in sequence or in whirling motion or changing 

interface in two or three dimensions.
C.	 1.	 Specific Purpose Application Package
	 2.	 Compiler
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	 Cyber Safety � Unit 2: Cyber Safety

Unsolved Exercise
Part A 

A.	 1.	 Firewall	 2.	 Password	 3.	 Cyber Stalking			
	 4.	 Virus, Worms, Trojan Horse, Spyware	 5.	 Antivirus
	 6.	 Quick Heal
B.	 1.	 iii	 2.	 iii	 3.	 ii
C.	 1.	 Internet	 2.	 Antivirus, Antispyware 	 3.	 Cookies	 4.	 Password	 5.	 Privacy
	 6.	 CERT-In	 7.	 spammer	 8.	 Booting	 9.	 Keylogger

Part B
A.	 1.	 i.	 Indian computer emergency Response Team			 
		  ii.	 Law Enforcement Agency	
		  iii.	 Master Boot Record
		  iv.	 Blue Screen of Death
	 2.	 i.	 Privacy: Privacy in Information Technology refers to personal control over one’s own files 

and documents. It also refers to the right and ability to keep control over the information 
that one reveals or uploads over the internet and to have a control over the selection of 
viewers or users who can access that information.

		  ii.	 Cyber Safety: Cyber safety is a measure to prevent or safeguard from cybercrimes or 
cyber attacks. It enables us to keep our personal information or data intact & secure and 
also protects organizations or individuals from unauthorised access or manipulation of 
information.

		  iii.	 Identity Protection: ‘Identity Protection’ refers to safety practices to prevent theft of 
personal information such as personal profile, bank account details, address details, 
family details and also to prevent from obtaining credit card benefits, ordered goods, 
passports, driving licenses, etc. by other person.

		  iv.	 Secure Transaction: A digital certificate represented by a golden lock in the web browser’s 
address bar signifies that the website is secure. Web addresses that start with ‘https’ also 
signify that the website is secure.

		  v.	 Spyware: Spywares are programs which infect and collect information of the computer 
without the owner’s knowledge or consent. A spyware generally infects a computer system 
by getting transmitted through internet, websites, webpages, e-mails or through network 
of computers. It intrudes into a computer and quietly steals the data of the computer. In 
other words, it refers to a kind of software which can track the activities of a computer 
system and report to the users. Keylogger is an example of a spyware.

2.
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		  vi.	 Password: A password can be termed as a key of codes that protect our valuable content, 
documents or files. It helps us to keep many of our belongings or documents secure or 
secret. We can safeguard our belongings by restricting their access to others through 
locks that can be opened only through password.

	 3.	 •	 Identity Protection Protect Username and Password, 
•	 	Do not share Personal Information
•	 	Secure Online Transactions
•	 	Avoid using Unsecured Wi-Fi
•	 	Don’t Accept Unknown Invitation
•	 	Use Antivirus and Antispyware Software
•	 	Clear Browser Cookies Frequently
•	 	Install Firewall
•	 	Never Install Software from Unknown Sources

	 4.	 Firewall could be either a software or hardware that helps in keeping a network secure. It 
analyzes the network traffic (flow of data) and determines whether the traffic should be 
allowed or not in the network. It also blocks unauthorised users to access data on the system. 
It can even keep a check on malware attacking the system.

	 5.	 Cyber stalking refers to the crime of using the Internet, e-mail, or other types of electronic 
communications to harass or threaten other people by following them online.

		  Cyber stalking involves sending harassing, absurd and nasty text messages, unethical videos 
and embarrassing pictures on social media or through mails. It also includes, faking someone’s 
profile or making a fake profile with wrong intentions and trying to befriend someone for 
immoral purposes.

	 6.	 Cybercrime includes many types of criminal activities, which can be broadly divided as:
	 	 •	 Crimes that target computer networks or devices viz., viruses and malware attacks.
	 	 •	 Crimes that use computer networks to facilitate other criminal activities viz., cyber stalking, 

fund transfers, identity theft, etc.
	 7.	 Malware refers to infectious programs that hampers the functioning of a computer system. 

It is unwanted software which is designed to damage a computer system. Some common 
types of malware are virus, worms, trojan horse, spyware, etc.

	 8.	 A computer virus is a type of unwanted computer program which is developed by miscreants 
with an intention to infect the files of a computer, to corrupt a database or to hamper the 
functioning of a computer system.

	 9.	 Worms are the computer programs or algorithms which are alien to the host computer and 
are designed to purposely slow down the functioning of a computer. Worms replicate inside 
the system and thus occupy a huge memory space in the storage device. Worms spread 
more commonly in computers that are connected on network. Examples of worms are Linux. 
Ballpit, B!gen3, Morris worm, W32/Nimda worm, Mydoom, Sasser etc.
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	 10.	Trojans are infectious programs which silently infect the computer and corrupt the files 
of a host computer. Such programs often accompany computer games, but unlike worms 
they don’t replicate themselves. They are active inside the computer when the user is busy 
interacting with the entertaining programs or with interface like computer games. Some 
examples of Trojan are Linux.Wifatch, Infostealer.Kronbank, etc.

	 11.	Spam refers to an unwanted and unsolicited message which is received in the inbox of a 
person’s e-mail account or in newsgroups. The one who sends the spams is called a ‘Spammer’. 
Generally, spams are sent with an intention to advertise products and services.

	 12.	A program file infecting virus is a type of malware that infects the executable files of a program 
with the intention of causing permanent damage or making the program useless. A file-infecting 
virus overwrites the code or inserts infected code into the source of an executable or program 
file. When such programs are executed, such virus is activated and damages the files.

	 13.	i.	 Mydoom, Sasser	 ii.	 Infostealer.Kronbank, Linux.wifatch
		  iii.	 OneInstaller, CiaDoor	 iv.	 Polyboot.B, Stones
		  v.	 Avast, McAfee			  vi.	 Windows, Mac
		  vii.	 OraNge3$, 30RaNgE#	 viii.	 Worms, Spyware
B.	 1.	 •	 Identity Protection Protect Username and Password, 

•	 	Do not share Personal Information
•	 	Secure Online Transactions
•	 	Avoid using Unsecured Wi-Fi
•	 	Don’t Accept Unknown Invitation
•	 	Use Antivirus and Antispyware Software
•	 	Clear Browser Cookies Frequently
•	 	Install Firewall
•	 	Never Install Software from Unknown Sources

	 2.	 Following are the tips for choosing a password: 
•	 Keep the length of the password of at-least 8 characters long, including a combination 

of numbers and symbols. 
•	 Avoid keeping passwords based on repetition, letters or number sequences. 
•	 Use a combination of upper-case and lower-case letters. 
•	 Avoid using the same password for multiple purposes. 
•	 Avoid using a piece of information about yourself that is publicly known to others as a 

password.
•	 Avoid keeping names of loved ones, relatives, friends, etc. as passwords.
•	 Having a strong password is important to safeguard oneself.
•	 Examples of strong password: aniKR@87@18, Esd{@37	



Touchpad Computer Application-IX (Answer Key)10

	 3.	 Cybercrime is a new trend of criminalization in our society. Governments across the globe 
are very strict against cybercrimes. In India, CERT-In (Indian Computer Emergency Response 
Team, Department of Electronics and Information Technology and Ministry of Communication 
& Information Technology) issues guidelines for preventing cyber-crimes on regular basis. 

		  CERT-In responds to the incidents that are related to computer or data security breaches. It 
takes the following measures in the area of cyber security: 

	 	 •	 It does collection, analysis and dissemination of information on cyber incidents. 
	 	 •	 It forecasts and alerts about cyber security probable incidents. 
	 	 •	 It provides emergency measures for handling cyber security incidents. 
	 	 •	 It issues guidelines, advisories, vulnerability notes related to information security practices, 

procedures & prevention.	
	 4.	 Confidentiality refers to keep the data or information secret and allowing only authorized 

people to access the information. The same information can be confidential for some 
individuals whereas non confidential for another set of individuals. The following data 
generally come under confidential category: 

	 	 •	 Medical history or records 
	 	 •	 Date of birth 
	 	 •	 Contact details 
	 	 •	 Income status 
	 	 •	 Itinerary, celebration photographs of family or friends
	 5.	 If you find any such situation of cyber stalking, then inform the stalker that you want him/

her to stop all such communications immediately. To take action against the stalker, you 
should: 

	 	 •	 Keep Evidence: Do not delete any email or other messages of the stalker and also keep 
a printout of the same. 

	 	 •	 Save all records: If there is any written threat by the stalker then keep it as a record. If 
the threats have been verbal only, then keep a record of the date, time and circumstances 
of those threats. 

	 	 •	 Contact stalker’s ISP: If Internet Service Providers (ISP) have concrete proof that any of 
their users has been using their service for harassing others, then they should immediately 
stop providing services to such people. 

	 	 •	 Keep Records: Keeps a record of all the complaints that you have made to an ISP or 
agency and also safely keep their official reports for future use.

	 6.	 CERT-In responds to the incidents that are related to computer or data security breaches. It 
takes the following measures in the area of cyber security: 

	 	 •	 It does collection, analysis and dissemination of information on cyber incidents. 
	 	 •	 It forecasts and alerts about cyber security probable incidents. 
	 	 •	 It provides emergency measures for handling cyber security incidents. 
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	 	 •	 It issues guidelines, advisories, vulnerability notes related to information security practices, 
procedures & prevention.

	 7.	 Victims of cybercrime can report to CERT-In, if he/she encounters any of the situations given 
below:

	 	 •	 Attempts (either failed or successful) to gain unauthorised access to a system or data.
	 	 •	 Making changes to system hardware, firmware, or software characteristics without owner’s 

consent.
	 	 •	 Email related security issues, spamming, mail bombing, malware attack, etc.
	 8.	 There are certain symptoms that hint that a computer has been infected by malware & virus, 

like:
	 	 •	 Slowdown: Fall in speed of processing of computer.
	 	 •	 Pop-ups: Appearance of unexpected pop-ups on the system.
	 	 •	 Crash: Frequent crashing of system or BSOD (Blue Screen of Death).
	 	 •	 Running Out of Storage Space: Occupying huge space of storage.
	 	 •	 Loss of File: Abrupt deletion of files of a computer system.
	 	 •	 �Unusual activity of messages or programs: Automatic opening or closing of a program, 

abrupt restarting of a computer and opening of strange or unknown windows during the 
process of booting.

	 	 •	 �Unusual Network Activity: Unusual network activity such as excessive transfer of data 
even when all the applications are closed.

	 9.	 Spyware: Spywares are programs which infect and collect information of the computer 
without the owner’s knowledge or consent. A spyware generally infects a computer system 
by getting transmitted through internet, websites, webpages, e-mails or through network of 
computers. It intrudes into a computer and quietly steals the data of the computer. In other 
words, it refers to a kind of software which can track the activities of a computer system and 
report to the users. Keylogger is an example of a spyware.

		  To prevent the attacks of spyware:
	 	 •	 Use anti-spyware (software)
	 	 •	 Avoid exploring the error dialogs on internet
	 	 •	 Avoid using free deal offers on internet
	 10.	i.	 How to Report Incidents to CERT-In: 
	 	 	 •	  Visit the website www.cert-in.org.in.
	 	 	 •	  Click on the ‘Incident Reporting’ link.
	 	 	 •	 �Double click on the ‘Security Incident Reporting Form’ link & download the incident 

reporting form.
	 	 	 •	 Fill the relevant details in the form and send it to CERT-In through:
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				    Email: incident@cert-in.org.in
				    Or Fax: +91-11-24368546
				�    Or Post: Indian Computer Emergency Response Team (CERT-In), Ministry of Electronics 

and Information Technology, Government of India, Electronics Niketan, 6 CGO 
Complex, Lodhi Road, New Delhi 110003, India.

		  ii.	 You can report incidents such as bug in a system (which bypass security measures such 
as Firewall Bypass) at www.cert-in.org.in. 

	 	 	 •	 Click on the ‘Vulnerability Reporting’ link. 
	 	 	 •	 �Double click on the ‘Reporting of a vulnerability’ link & download the vulnerability 

reporting form. 
	 	 	 •	 �Fill the relevant details in the form and send it to CERT-In through: 
				    E-Mail: vulnerability@cert-in.org.in 
				    Or Fax: +91-11-24368546 
				�    Or Post: Indian Computer Emergency Response Team (CERT-In), Ministry of Electronics 

and Information Technology, Government of India, Electronics Niketan, 6 CGO 
Complex, Lodhi Road, New Delhi 110003, India.

C.	 1.	 Web address must start with ‘https’
	 2.	 Using Antivirus and Antispyware

	 Working with Word Processor � Unit 3: Office Tools

Unsolved Exercise
Part A 

A.	 1.	 Spelling & Grammar 	 2.	 Bullets and Numbering	 3.	 Fields	
	 4.	 Symbol	 5.	 Autoformat	
	 6.	 Page Style option – Borders tab
B.	 1.	 ii	 2.	 ii	 3.	 iv
C.	 1.	 .odt	 2.	 Clipboard	 3.	 Character spacing	
	 4.	 Page Margin	 5.	 marks	 6.	 AutoSpellcheck
	 7.	 Cell	 8.	 merged	 9.	 splitting		

Part B
A.	 1.	� Format Paintbrush
	 2.	 To insert a table in a document, follow the given steps:
		  Step 1: Position the insertion point where the table has to be inserted.
		  Step 2: Click on ‘Table’ drop-down button from the standard toolbar. 

3.
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		  Step 3: �Click and hover the mouse pointer across the grid to select the desired number of 
columns and rows.

		  Step 4: Release the mouse button. The table will be created.
	 3.	 0.5”
	 4.	 To insert a symbol, follow these steps:
		  Step 1: �Place the cursor where the symbol has to be inserted and select ‘Special Character’ 

option from ‘Insert’ menu. A dialog box titled ‘Special Characters’ with various symbols 
appears on the screen.

		  Step 2: Click on the required symbol.
		  Step 3: Click on ‘OK’ button to insert the selected symbol.
	 5.	 Track changes feature in ‘Writer’ helps a user to keep a record of formatting, text insertions, 

deletions and comments made by multiple editors. A final document can then be created 
by accepting or rejecting the proposed changes. 

B.	 1.	 A word processing package is software that provides methods and mechanisms to type 
text and create documents. It allows editing, modifying, printing and saving the contents 
electronically making our work much easier.

		  The important features of word processor that make it useful are:
•	 Editing: In a word processor, editing of a document can be easily done without making 

the document messy. There is no need to retype the whole document while doing 
alterations.

•	 Interface: A word processor provides layout i.e., interface which makes it convenient to 
type document without using paper or stationery.

•	 Navigation between pages: A user can easily switch from one page to any other page 
of a document instantly in a word processor to view or to edit it.

•	 Formatting: A word processor provides various options for formatting the text, for e.g., 
the user can change the look of the document by changing its font colour, size, style, 
appearance, etc.

•	 Graphics: In a word processor, graphical pictures can be added in the document. Various 
tools to draw figures are also present in many word processors.

•	 Spelling and Grammar: Word processor can detect the spelling and grammatical mistakes 
in a document and provide suggestions to rectify them.

•	 OLE: In a word processor, there is an Object Linking and Embedding feature that helps to 
link or embed various objects in a document from outside. These objects can be charts, 
equations, cliparts, pictures, etc.

•	 Mail Merge: In word processor, multiple copies of the same document can be generated 
which can be sent to different recipients or destinations or addresses using mail merge 
feature.
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•	 Auto Complete: Auto Complete feature of a word processor helps in automatic typing 
of certain words, phrases, symbols, etc. Such words may be frequently used words or 
may be some special words like name, phone number, etc. which has been frequently 
used in the document.

•	 Find and Replace: Word processor helps to search a word or phrase in the document and 
also helps to replace a particular word or phrase in the entire or a part of the document.

	 2.	 Margin is the gap between the edge and beginning of text i.e., the outer boundary of the 
text in a document beyond which the contents of the document do not flow. Normally, in a 
document, the default margins are 0.79” on top and bottom and 0.79” on the left and right.
•	 Left margin: The space between the text and the left edge of the page is referred as the 

‘Left margin’.
•	 Right margin: The space between the text and the right edge of the page is referred as 

the ‘Right margin’.
•	 Top margin: The space between the text and the top edge of the page is referred as 

the ‘Top margin’.
•	 Bottom margin: The space between the text and the bottom edge of the page is referred 

as the ‘Bottom margin’.
	 3.	 Header and Footer is the mark of identification or reference of the text which is displayed on 

every page of a document. Header or Footer contains information such as page numbers, 
date, logo of a company, title or file name of the document, etc. Header is the repetitive text 
that is printed at the top of every page whereas footer is the repetitive text that is printed 
at the bottom of every page in a document. By default, header or footer is printed at 0.5” 
gap from the edge of the page.

		  To add Header or Footer:
		  Step 1: �Select ‘Header’ or ‘Footer’ option from the ‘Insert’ menu. A sub-menu displaying the 

option ‘Default’ appears on the screen.
		  Step 2: Click on the ‘Default’ option.
		  Step 3: �A rectangular box appears at the top of the document with a blinking cursor inside 

it. Type the text on it, say ‘ORANGE EDUCATION’.
		  Step 4: Click the mouse button outside the rectangular area.
	 4.	 Line spacing is the vertical gap between different lines of text in a paragraph. It is measured 

in lines or in points. It can be set to single spacing, 1.5 lines spacing.
		  Different options of Line spacing are:

•	 Single: It provides single line spacing, according to the point size of the font. It is the 
default line spacing that exists in a normal document.

•	 1.5 lines: It provides one and a half line size spacing, according to the point size of the font.
•	 Double: It provides double line spacing, according to the point size of the font.



15Touchpad Computer Application-IX (Answer Key)

•	 At least: It sets minimum spacing between the lines. This option is useful if there are 
fonts and lines of different sizes in the paragraph.

•	 Proportional: It allows to enter a percentage value in the box for line spacing, where 
100% corresponds to a single line spacing.

•	 Leading: It sets the height of the vertical space that is inserted between two lines.
•	 Fixed: It sets the line spacing to exactly match the value that is entered in the box. This 

can result in cropped characters.
	 5.	 To insert date and time in OpenOffice Writer, follow the given steps:
		  Step 1: Place the cursor where the current date and time has to be inserted.
		  Step 2: To insert Date and Time, select the option ‘Fields’ from the ‘Insert’ menu.
		  Step 3: �Click on ‘Date’ to insert the system date or click on ‘Time’ to insert the system time 

in the document.
		  Step 4: Inserted Date and Time appears as shown below.
	 6.	 Combining two or more adjacent cells in the same row or column is known as merging of 

cells.
		  Step 1: Select the adjacent cells.
		  Step 2: Select ‘Merge Cells’ option from the ‘Table’ menu.
		  Division of cells into two or more sub-cells is known as splitting of cells. To split the cells 

follow these steps:
		  Step 1: Place the cursor in the cell that has to be split.
		  Step 2: Select ‘Split Cells’ from the ‘Table’ menu. ‘Split cells’ dialog box appears on the screen.
		  Step 3: �For splitting of cell into desired number of columns, specify how many cells the cell 

is to be split.
		  Step 4: �For splitting of cell into rows, a cell must be split horizontally. Specify this detail 

under ‘Direction’.
		  Step 5: �For splitting of cell into columns, a cell must be split vertically. Specify this detail in 

this dialog box as shown.
		  Step 6: Click on ‘OK’ button.
	 7. 	 To insert mathematical expressions, follow these steps: 
		  Step 1: �Select ‘Object’ from the ‘Insert’ menu and choose the option ‘Formula’ from the 

sub-menu. Formula window appears on the screen.
		  Step 2: Right click on the ‘Edit window’. 
		  Step 3: Select the desired formula type. 
		  Step 4: Edit Window 
		  Step 5: �‘Elements’ dialog box appears with several options. Select the desired expression say 

‘a>b’. The expression will appear as ‘<q> > <q>’ in the document and appears as 
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‘<?> > <?>’ in the ‘Edit’ window. Edit the given expression as per the need in ‘Edit 
and Element’ window. 

		  Step 6: �After inserting the expression erase the right and left angular bracket and click any 
where in the document window to close the Edit window.

C.	 1.	 Mathematical Expression
	 2.	 Character spacing, Line spacing and Paragraph spacing

	 Working with Presentation � Unit 3: Office Tools

Unsolved Exercise
Part A 

A.	 1.	� Shape	 2.	 Notes and Handouts	 3.	 Slide sorter view	 4.	 .odp
	 5.	 Spelling & Grammar
B.	 1.	 iv	 2.	 i	 3.	 iv
C.	 1.	 Watermark	 2.	 Template	 3.	 Slide show	 4.	 Bitmap	 5.	 Drawing

Part B
A.	 1.	 i.	 Title Slide
		  ii.	 Title
	 2.	 To create a new presentation with an empty presentation:
		  Step 1: Select ‘Empty presentation’ from ‘Presentation Wizard’ and click on the ‘Next’ button.
		  Step 2: Select a slide design.
		  Step 3: Set the output medium.
		  Step 4: Click on ‘Preview’ check box to see the preview.
		  Step 5: Click on ‘Create’ button.
	 3.	 It has options which help to insert new slides and different types of contents (table, picture, 

object, chart, animation, page number, date and time, etc.) 
		  To activate it, click on ‘Insert’ menu or Press ‘Alt+I’ keys. 
	 4.	 Open Office Impress, MS PowerPoint, Adobe Director, 3-D Studio, etc.
	 5.	 To automatically check the spellings and grammatical mistakes in the text of a presentation.
B.	 1.	 To make a presentation with the help of Template:
		  Step 1: Click on ‘From template’.
		  Step 2: Click on ‘Next’ button.
		  Step 3: Select a slide design for the presentation being created.
		  Step 4: To see the preview, check the ‘Preview’ button.

4.
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		  Step 5: Select desired output medium
		  Step 6: Click on the ‘Next’ button.
		  Step 7: �Select ‘Effect/Speed’ of slide transition and set the presentation type as (Default/

Automatic).
		  Step 8: In case of ‘Automatic’ enter the ‘Duration of page’ and ‘Duration of pause’.
		  Step 9: Click on the ‘Next’ button.
		  Step 10: A wizard screen asking for description of presentation appears on the screen.
		  Step 11: Enter basic details of presentation.
		  Step 12: Click on the ‘Next’ button.
		  Step 13: Select the pages to be used in the presentation and click on the ‘Create’ button.
	 2.	 i.	 Workspace: It is the basic layout or working area where the content of a slide is entered. 

It has five tabs: Normal, Outline, Notes, Handout and Slide Sorter.
		  ii.	 Edit menu: It has options which perform basic operations related to editing or modifying 

the contents of a presentation. To activate it, click on ‘Edit’ menu or Press ‘Alt+E’ keys.
		  iii.	 ‘Display Grid’ command of Standard Toolbar: Specifies the setting for the configuration 

grid on a document and helps to determine the exact position of objects.
		  iv.	 ‘Bullets & Numbering’ command of Formatting Toolbar: To add/edit format of bullets.
		  v.	 Presentation Toolbar: It generally lies besides the standard tool bar to the right side of 

the screen. The buttons found on this bar are: slide, slide layout, slide design and slide 
show.

	 3.	 A placeholder is a box with a dotted boundary in a presentation that provides you with an 
area to add text/image/charts/graphics etc. to a slide.

		  To enter text using a placeholder, follow the given steps: 
		  Step 1: �Click in the text boxes to start typing. If the text takes more than one line, Impress 

automatically wraps the text to the next line. 
		  Step 2: To end typing, click outside the text box.
	 4.	 Bitmap enables to select picture from a range of existing pictures like: sky, water, marble, 

leaves, etc. It can be previewed by clicking on any one of the bitmap pictures.
		  Step 1: On the ‘Background’ tab, select ‘Bitmap’ option. 
		  Step 2: Choose the desired bitmap. 
		  Step 3: Click on ‘OK’ button. 
		  To apply same background to each slide, click on ‘Yes’ button in the ‘Page Settings’ dialog 

box.
	 5.	 •	 Inserting Header and Footer: Header and Footer is the information of a page which 

is separated from the main body of the text and appears at the top and the bottom of 
the page. To make the presentation more effective and informative, the user can write 
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the topic name, date & time, slide number and the event name for which the slides are 
presented. The user can display the slide number as the footer. Header is visible only in 
Notes and Handout view.

	 	 •	 Background: Applying In ‘Impress’, different types of coloured backgrounds can be 
applied to the slides. To change the background of one or more slide(s), select a slide 
from the slides list on the left side.

C.	 1.	 Background
	 2.	 Slide show

	 Effects in Presentation� Unit 3: Office Tools

Unsolved Exercise
Part A 

A.	 1.	 Slide show	 2.	 Handouts	 3.	 Area chart	
	 4.	 Chart wizard	 5.	 Insert
B.	 1.	 i	 2.	 iv	 3.	 i
C.	 1.	 Organised, interesting	 2.	 Charts	 3.	 Ctrl, P
	 4.	 Slide layout	 5.	 Column chart

Part B
A.	 1.	 Handouts are thumbnails of all the slides printed together. By default, thumbnails of six 

slides are accommodated in a sheet of A4 size paper.
	 2.	 ‘Notes’ view allows you to add reference or notes for your help to the slides in a presentation. 

In the notes view, the slides are displayed in a reduced form towards the upper side of the 
slides. At the bottom, a text box appears in which reference to the slide can be added.

	 3.	 One can set the timings of the slides that appear during a presentation in two ways:
•	 Setting the time manually 
•	 Rehearse Timings

	 4.	 Slide layout refers to the basic look or the frame of types of slides in which contents can be 
added. In ‘Impress’, there are various types of predefined layouts for creating slides which 
can be used for creating a new presentation. Some frequently used layouts are Title Slide, 
Content, Title-Only, Blank Slide, etc. In the task pane area, there are different layouts. These 
layouts contain different placeholders to place different types of content.

	 5.	 The presentation can be viewed in six different modes, i.e., Normal, Outline, Notes, Handout, 
Slide Sorter and Slide Show View.	

B.	 1.	 i.	 Custom Animation: This feature enables to set timings between the display of the 
content or objects of the slides and also enables to apply different whirling effects to 
animate the object.

5.
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		  ii.	 Slide Transition: Slide Transition sets the style of appearance of slides in a presentation. 
It is the effect applied when a slide changes to another during on-screen presentation 
or slide show.

	 2.	 Presentation is a way of systematic display of information. It includes pictures, texts, graphics, 
audio, videos and animated objects which are organized and presented in a proper sequence.

		  Various ways in which we can add multimedia features in a presentation are:
		  Inserting Pictures: To insert pictures in slides, follow the given steps:
		  Step 1: Select the option ‘Pictures’ from Insert Menu.
		  Step 2: Click on ‘From File’ option.
		  Step 3: Locate the picture.
		  Step 4: To view the picture before inserting, click on ‘Preview’.
		  Step 5: Click on ‘Open’ to insert the picture.
		  Adding movie or sound into the presentation: To add movie or sound into the presentation, 

follow the given steps:
		  Step 1: �Select the option ‘Movie and Sound’ from Insert menu. ‘Insert Movie and Sound’ 

dialog box appears on the screen.
		  Step 2: Locate the source of movie/sound to insert.
		  Step 3: �Click on ‘Open’ to insert the selected movie/sound. The sound effect gets applied 

to the presentation, whose icon appears on the slide.
		  Inserting Media:
		  Step 1: �Click on the drop-down button of ‘Slide Layout’ option from the standard toolbar. 

A drop-down menu appears on the screen.
		  Step 2: Select the ‘Title, Content’ slide layout.
		  Step 3: Click on ‘Insert picture’ option.
	 	 Step 4: Select the desired picture.
		  Step 5: Click on ‘Open’ button. The selected picture will be inserted in the slide.
	 3.	 Types of Charts: There are different types of charts. Some of them are:

•	 Line Chart: Line chart is used to view information that is shown by lines at equal intervals. 
It depicts the change in data over a period of time.

•	 Column Chart: A column chart represents the data over a period of time in columns. 
Each column rises from X-axis and indicates the value of a data. The measurement values 
are shown vertically as Y-axis.

•	 Bar Chart: A bar chart represents the data in horizontal columns. The measurement of 
values are organized horizontally. Stacked bar chart is a variation of bar charts.

	 4.	 To apply the transition effect:
	 	 Step 1: Select the slide to which the transition is desired.
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		  Step 2: Select the ‘Slide Transition’ option.
		  Step 3: Click on any of the transition effect.
		  Step 4: Set the speed of display (Slow, Medium, Fast) and sound effect.
		  Step 5: Repeat the above steps to apply such effects in other slides.
		  OR 
		  To apply the same transition to all the slides in the presentation, click on ‘Apply to All Slides’. 

The duration of time for the display of a slide can be set either automatically or the slides 
can be advanced manually using a mouse.

C. 	 1.	 Tips for effective presentation are:
•	 Prepare well about the topic of the presentation.
•	 Cover most important points in the beginning.
•	 Be aware of who is going to be the audience – teacher, students, parents, businessmen, etc.
•	 Rehearse and practice well for the presentation.
•	 Keep the slides simple.
•	 Use limited words on slides.
•	 Use photographs and pictures of high resolution and quality.
•	 Use relevant charts.
•	 Use accurate data from reliable sources.
•	 Choose appropriate fonts.
•	 Choose eye-catchy colour combination.
•	 Keep the formatting clean and simple.
•	 Suitably align the objects on the slides.
•	 Practice well using the timer.
•	 Don’t speak too fast, let the audience understand and think what you want to convey.
•	 Use voice modulation for emphasising different parts of the presentation.
•	 Do not use too much animation and transitions.
•	 Use professional graphics instead of clipart.
•	 Customise the templates according to your requirements.
•	  Interact with the audience in between the presentation.

 	 2.	 Handouts
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	 Working with Spreadsheet� Unit 3: Office Tools

Unsolved Exercise
Part A 

A.	 1.	 65, 536	 2.	 A selected cell is an active cell	 3.	 Ctrl + S	
	 4.	 Navigator	 5.	 Ctrl + Y	 6.	 AutoFill
B.	 1.	 iii	 2.	 iii	 3.	 ii
C.	 1.	 1024	 2.	 Text Orientation	 3.	 AutoFill
	 4.	 Function	 5.	 .ods

Part B
A.	 1.	 User can hide worksheet(s) of a workbook which can be displayed later. To hide a worksheet, 

follow these steps:
		  Step 1: Select the sheet(s) to be hidden.
		  Step 2: Select the option ‘Sheet’ from the ‘Format’ menu. Click on the ‘Hide’ option.
	 2.	 Adding a Sheet: ‘Calc’ workbook opens with three sheets by default. But the user can add 

more sheets, if required. To add new sheets in the workbook, follow these steps:
	 	 Step 1: �Right click on ‘Sheet’ tab and select ‘Insert Sheet’ option. ‘Insert Sheet’ dialog box 

appears.
		  Step 2: Set the position where the new sheet is to be added in the workbook.
		  Step 3: Specify the number and the name of sheet to be created.
		  Step 4: Click on the ‘OK’ button. A new worksheet will be added before the active sheet.
	 3.	 It is a feature in spreadsheet package like ‘Calc’ in which a certain kind of predefined series 

of data such as name of months of a year, serial numbers, etc. are automatically generated 
once the user feeds the initial data.

		  To print series of months of the year:
		  Step 1: Type the initial data (month name) of the series in one cell.
	 	 Step 2: �Select the cell. An AutoFill handle (a small black plus sign) appears at the bottom-

right corner of the selected cell.
		  Step 3: �Click the Auto Fill handle tool and drag it over the range of cells to fill the defined 

series, then release the mouse button. The series of months will be displayed. (The 
given series is displayed because it is predefined/stored as a custom list)

	 4.	 Different types of data that can be entered in a cells:
	 	 •	 Numeric Data: ‘Numeric Data’ consists of digits (0–9), ‘e’ (Exponential), decimal (.) 

and numeric operators like +,-,/,*,%,$. Numeric data or values are aligned towards the 
right side in a cell. The numbers or values on which formulae are applied to perform 
mathematical operations are called OPERANDS.

6.
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	 	 •	 Alphanumeric or Text Data: Alphanumeric data are the data which are textual in 
nature. It refers to the data which is a combination of alphabet, spaces, digits and/or 
other characters. Alphanumeric data is mentioned within double quotes “ ”. In Calc, 
alphanumeric data are aligned (by default) towards the left side of the cell and are 
generally not meant for calculation.

	 	 •	 Date and Time: ‘Calc’ displays date as sequential numbers known as Serial Values. The 
time is displayed as fractional part (it is considered as a part of a day). Date and Time 
are values and therefore can be added or subtracted and can be included for other 
calculations. They are aligned (by default) towards the right side of the cell.

	 	 •	 Formula: A formula is an expression which helps to perform arithmetical calculation and 
also executes nonarithmetical tasks. It consists of the operands and the operators which 
operate upon the data. A formula always starts with an ‘=’ sign.

	 5.	 •	 Wrap Text: This option wraps the text in multiple lines to accommodate it automatically 
within the column width by increasing the row height.

	 	 •	 Shrink to fit Cell size: This option reduces the font size of the contents to accommodate 
it within the column width.

B.	 1.	 Function Result
OR Produces true if any condition enclosed in bracket is true, 

otherwise it will produce false.
Eg.  =OR(5>3; 4<5;4>15) will display true.
	 =OR(3>6; 2<1) will display false.

AND Produces true if all the conditions enclosed in bracket is true 
otherwise it will display false.
Eg.=AND(5>3; 4<5; 4>15) will display false. (As one of the 
condition is false)
=AND(5>3; 4<5) will display true. (As all of the conditions are 
true.)

	 2.	 An operator is a symbol that performs certain mathematical or logical operations. In a cell, the 
calculation takes place in the order of precedence of operators (in a similar way as BODMAS 
in mathematics).

		

Operator Description
: Reference operator (as in A2:A20)
- Negation operator
*,/ Multiplication, Division
* Text Concatenation

Operator Description
, ; Argument Separator
^ Exponent
+, - Addition, Subtraction
>,<,>=,<=,<> Comparison operator

	 3.	 In a worksheet, if the user does not want to show columns or rows that contain some part 
of data on the screen, it can be hidden with the help of ‘Hide’ feature. Individual cell can’t 
be hidden in the spreadsheet. To hide a column:
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		  Step 1: Select the column to be hidden.
		  Step 2: Right click on the column header.
		  Step 3: Select the option ‘Hide’.
	 4.	 i.	 Formula Bar: ‘Formula Bar’ lies below the formatting toolbar. It displays the content 

of the active cell. Formula that perform different calculations in cells are entered and 
displayed here. It is denoted by ‘fx’.

		  ii.	 Operands: The values or variables involved in an operation.
		  iii.	 Sheet Tab: It lies below the active sheet of the screen. The names of the worksheets 

appear in the sheet tabs at the bottom of the workbook. We can click on the specific 
sheet tab to open it.

		  iv.	 Formatting Cells: Formatting a cell includes changing the contents of cell with respect 
to appearance i.e., changing Text, Styles, Alignment, Font, Font style, Font size, Border, 
Patterns, etc. of a cell or the contents of a cell.

C. 	 1.	 Wrap Text		  2.	 AutoSum

	 Data Analysis� Unit 3: Office Tools

Unsolved Exercise
Part A 

A.	 1.	 = A2 + A3	 2.	 =C4/(A3 * A5)	 3.	 =MIN(B3 : B7)	 4.	 =COUNT(D6 : D30)	
	 5.	 = 5 ^ 4
B.	 1.	 ii	 2.	 iv	 3.	 i
C.	 1.	 Cell referencing	 2.	 Absolute	 3.	 Chart	 4.	 Sorting			 
	 5.	 #REF!

Part B
A.	 1.	 Function Result

OR Produces true if any condition enclosed in bracket is true, 
otherwise it will produce false.
Eg.  =OR(5>3; 4<5;4>15) will display true.
	 =OR(3>6; 2<1) will display false.

AND Produces true if all the conditions enclosed in bracket is true 
otherwise it will display false.
Eg.=AND(5>3; 4<5; 4>15) will display false. (As one of the 
condition is false)
=AND(5>3; 4<5) will display true. (As all of the conditions are 
true.)

7.
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	 2.	 An operator is a symbol that performs certain mathematical or logical operations. In a cell, the 
calculation takes place in the order of precedence of operators (in a similar way as BODMAS 
in mathematics).

		

Operator Result
: Reference operator (as in A2:A20)
- Negation operator
*,/ Multiplication, Division
* Text Concatenation

Operator Result
, ; Argument Separator
^ Exponent
+, - Addition, Subtraction
>,<,>=,<=,<> Comparison operator

	 3.	 i.	 Occurs when a wrong type of argument or operand is used.
		  ii.	 Occurs when a cell reference is not valid.
	 4.	 In a worksheet, if the user does not want to show columns or rows that contain some part 

of data on the screen, it can be hidden with the help of ‘Hide’ feature. Individual cell can’t 
be hidden in the spreadsheet. To hide a column:

		  Step 1: Select the column to be hidden.
		  Step 2: Right click on the column header.
		  Step 3: Select the option ‘Hide’.
	 5.	 i.	 It is the set of values which the user wants to plot in the chart.
		  ii.	 In a 3-D chart, the base area or the plane in X-Y axis is called the floor and the vertical 

area, i.e., planes is X-Z and Y-Z axis are called walls. 
B.	 1.	 Formulas can be applied on a large data set to perform various mathematical operations 

such as addition, subtraction, division, multiplication and many more.
		  Different type of cell referencing used in Calc:
		  i.	 Formula With Cell Addresses: Each cell in the worksheet has a unique address that is 

formed by the intersection of its Column and Row, for example, ‘A10’. Here, ‘A’ is the 
Column name and ‘10’ is the Row number.

			   Calculations are performed on cells on the basis of Cell Addresses mentioned, while 
writing the formula. The formula thus applied displays the result of the calculations done 
on the data stored in the mentioned cell addresses.

		  ii.	 Formula With Cell Names: In ‘Calc’, Formula can be applied in reference to cell names. 
For doing so, first define the name of the cell or the range of cells.

			   For naming a cell, click on the cell and type the name for that cell in the name box, and 
press Enter. Name can be used directly in a formula.

		  iii.	 Formula With In-Built Functions: Functions are in-built formula in ‘Calc’, which can be 
used to perform arithmetical and non-arithmetical tasks. In ‘Calc’ there are more than 
375 in-built functions which can be applied directly or as part of a formula. For Example: 
A formula, say =A1+A2+A3+A4+A5 can be written using the ‘SUM’ function along with 
cell range as: =SUM(A1:A5).
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	 2.	 The identification or address of a cell in a formula is known as a ‘Cell Reference’. There are 
three types of referencing in ‘Calc’.
•	 Relative Referencing 
•	 Absolute Referencing
•	 Mixed Referencing

		  i.	 Relative Referencing: It is based on the position of the cell in which the formula is typed 
with respect to the cell address of the formula. When we copy or move the formula to 
other cells, the reference (cell address) automatically changes according to the relative 
position of cells in consideration.

		  ii.	 Absolute Referencing: It is applied when a user does not want to change the value 
while copying the formula with cell address to another cell. To apply an absolute cell 
reference, a ‘$’ (dollar) sign is prefixed before the row number and/or the column name 
in the cell address. (i.e. $ sign fixes the value).

		  iii.	 Mixed Referencing: This type of cell referencing is the combination of absolute and 
relative referencing. While applying mixed referencing, either the row number or the 
column name of the cell address in the formula is fixed. The cell references such as $F5 
or F$5 are examples of mixed referencing. $F5 means that the column F is absolute and 
row 5 is relative while F$5 means that the column F is relative and row 5 is absolute.

	 3.	 A function contains ‘Name’ and ‘Argument’.

		  ‘Name’ is the function that signifies the nature of operation. ‘Argument’ specifies the values 
or the range of cells on which the specific operation is being applied and is always enclosed 
within the opening and closing parenthesis (i.e., Name refers to the operator and Argument 
refers to the operand).

	 4.	 Errors Reasons
#### Occurs when the cell contains a number, data or time that is wider 

than the cell width or when the cell contains a date and/or time 
formula that produces a negative result.

#VALUE Occurs when a wrong type of argument or operand is used.
#NAME Occurs when ‘Calc’ does not recognize text in a formula.
#NUM Occurs when there is a problem with a number in a formula or 

function.
#REF! Occurs when a cell reference is not valid.
#DIV/0! Occurs when a formula is divided by zero.
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	 5.	 It is a visual or graphical representation of data from a worksheet which is very useful for 
instant analysis and decision making.

		  There are different types of charts. Some of them are:
•	 Line Chart: Line chart is used to view information that is shown by lines at equal intervals. 

It depicts the change in data over a period of time.
•	 Column Chart: A column chart represents the data over a period of time in columns. 

Each column rises from X-axis and indicates the value of a data. The measurement values 
are shown vertically as Y-axis.

•	 Bar Chart: A bar chart represents the data in horizontal columns. The measurement of 
values are organized horizontally. Stacked bar chart is a variation of bar charts.

•	 Pie Chart: A pie chart represents the data or value of each item in proportion or percentage 
to the consolidated or the sum value of all items. Pie chart displays single type of data 
item and is beneficial when the user wants to emphasize value of a significant item. Pie 
charts help to compare how each value relates proportionally to the whole.

•	 X-Y (Scatter) Chart: X-Y (Scatter) chart displays the relationships among the numeric 
values of several data series. This chart shows uneven intervals or clusters of data and is 
commonly used to represent scientific data.

•	 Area Chart: An area chart is a version of a line or column graph. It is useful to emphasize 
on volume of changes of data. Area charts have better visual impact than a line chart.

C.	 1.	 Spreadsheet or Calc
	 2.	 This error occurs when the cell contains a number, date or time that is wider than the cell 

width or when the cell contains a date and time formula that produces a negative result.
	 3.	 =AVERAGE(B2 : B7)

	 Scratch� Unit 4: Scratch or Python

Unsolved Exercise
Part A 

A.	 1.	 New Sprite	 2.	 (0, 0)	 3.	 Script Area
	 4.	 Green	 5.	 .sb2, .sb3
B.	 1.	 iii	 2.	 i	 3.	 iii
C.	 1.	 480, 360	 2.	 full	 3.	 Sprite
	 4.	 Duplicate	 5.	 Choose sprite from library
D.	 1.	 i.—(iii)	 2.	 ii.—(v)	 3.	 iii.—(i)	 4.	 iv.—(ii)	 5.	 v.—(iv)

8.
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Part B
A.	 1.	 i.	 Stage Toolbar: The stage toolbar is located above the stage. It contains the following 

tools:

Buttons Command Name Purpose of the Button

Select and duplicate It helps to make duplicate copy of the 
objects. 

Delete It helps to delete the objects.

Grow sprite It helps to increase the size of the sprite.

		  ii.	 Sprite List: It displays the thumbnail list of all the sprites that have been used in the 
currently opened project. The name of each sprite appears below its thumbnail. 

			   If we right click on the thumbnail, it displays the mentioned options: 
	 	 	 •  Info: It opens the information panel related to the sprite.
	 	 	 •  Duplicate: It makes a copy of the sprite.
	 	 	 •  Delete: It removes a sprite from the project.
	 	 	 •  Save to local file: It saves the sprite.
	 	 	 •  Hide: It hides the sprite.
	 2.	 Animation is the display of sequence of images in order to create extraordinary illusions. It 

includes computer generated imagery (CGI) and multimedia features. This has resulted in 
creation of more convincing illusions.

	 3.	 It is a small graphic object that moves on the stage. The default sprite is a ‘cat’, which can 
also be changed as per our wish. The sprite moves, plays music and executes other functions 
as per our instructions.

	 4.	 Script area contains the scripts. A script is a collection of graphics/blocks that are assembled 
in a particular order that executes from the top to the bottom.

	 5.	 It displays the information about a sprite such as its name, coordinates: x-y position, 
direction in degree (0°=up, 90°=right, 180°=down, -90°=left), lock state, rotation style, etc. 
Here, you can set the name of sprite, its direction, lock or unlock and the rotation style of 
the sprite.

	 6.	 A script is a collection of graphics/blocks that are assembled in a particular order that executes 
from the top to the bottom.
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	 7.	
Title Bar

Menu Bar

Stage
Script Area

Blocks Palette

Stage Toolbar

Blocks Menu

Sprite

Sprite List

New Sprite 
Buttons

B.	 1.	 To open an existing project, follow these steps:
		  Step 1: Select ‘Open’ from the File menu. ‘Open Project’ window appears.
		  Step 2: Navigate to the location where the projects are saved.
		  Step 3: �Select the project to be opened from the list and click on the ‘OPEN’ button. The 

chosen project opens on the Scratch window screen.
		  Step 4: �To view the animation, click on the green flag from the stage toolbar. Green Flag 

button is used to run a program in scratch. Stop button stops the execution of the 
current project.

	 2.	 A sprite can be made bigger or smaller. To resize a sprite:
		  Step 1:	 Click on ‘Grow sprite’ / ‘Shrink sprite’ button.
	 	 Step 2:	 �Place the mouse pointer on the sprite in the stage area and keep on clicking till the 

required size is obtained.
	 3.	 To draw a sprite, say a clone or joker in the paint editor.
		  Step 1: Click on the ‘Eyedroper’ tool.
		  Step 2: Select the desired colour.
		  Step 3: Select ‘Ellipse’ tool.
		  Step 4: Drag to draw the face of image.
		  Step 5: Select ‘Ellipse tool’ and drag to draw the eyes.
		  Step 6: Select ‘Line tool’ and drag to draw nose, mouth and hat.
		  Step 7: Change the foreground colour and fill the colour in hat using the ‘Fill Tool’.
		  Similarly, draw the body of the image by performing the following steps:
		  Step 1: Draw the body of the image using ‘Ellipse tool’.
		  Step 2: Draw the collar of the costume using ‘Line tool’.
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		  Step 3: Draw the pockets on the costume using ‘Rectangle tool’.
		  Step 4: Fill the colours of your choice using ‘Fill tool’.
		  Step 5: Select the ‘Ellipse tool’ and draw the buttons on costume.
		  Step 6: �Click on ‘Stamp tool’ and copy the button. Drag the copied button to place it on the 

costume.
		  Step 7: Use ‘Select tool’ and move the toy on the left side of editor screen.
		  Step 8: Type ‘Hello Scratch…’ on the screen using ‘Text’ tool.
		  Step 9: Move it to the desired location by dragging with the help of ‘Select tool’.
C.	 1.	 1.	 Erase Tool in Paint Editor window
		  2.	 To choose a sprite from the scratch library:
	 		  Step 1: Click on ‘Choose sprite from library’ button of ‘New sprite’ section.
			   Step 2: �The ‘Sprite Library’ dialog box appears. Select the category from the left pane. 

A list of sprites related to the selected category appears.
			   Step 3: �‘Select the desired sprite and click on ‘OK’. The selected sprite appears on the 

stage area.

	 Animation in Scratch� Unit 4: Scratch or Python

Unsolved Exercise
Part A 

A.	 1.	 Untitled	 2.	 Loop	 3.	 Pen
	 4.	 Motion	 5.	 Stop the execution of script
B.	 1.	 ii	 2.	 i	 3.	 i
C.	 1.	 Pen	 2.	 Motion	 3.	 Events
	 4.	 Stop [all]	 5.	 Control

Part B
A.	 1.	 i.	 Motion block: 	This block enables the sprite to move. 
			   Move 10 steps: This command moves the Sprite by a specified number of steps in the 

forward direction. To move the sprite in the backward direction, we need to give a 
negative step value. 

			   Turn command: This block is used to turn the Sprite in Clockwise/Anti clockwise direction.
		  ii.	 Pen block: In Scratch, the Pen commands make the sprites act as if it were writing 

instrument. The Pen colour, shade and size can be changed. To apply the pen 
programming blocks:

9.
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•	 	Click on ‘Pen’ block in the blocks menu.
•	 	Drag the programming blocks from the ‘Block palette’ and keep it in the ‘Script Area’.
•	 	Set the values as per requirement.

			   Following are the commands that are found under the Pen block: 
•	 Pen Down: This block draws a line on the stage, in the direction in which the Sprite 

moves. 
•	 Set Pen Size: This block helps set the thickness of the pen. 
•	 Change Pen Color: This block changes the color of the pen.

		  iii.	 Control block: This block contains two main programming blocks; ‘Conditional block’ 
and ‘Loop block’. Conditional blocks are if-else blocks. They check the correctness of 
the condition as per the value given by the user. If the value is ‘true’, then it will execute 
the blocks that are snapped within, otherwise it will execute the blocks that are kept 
outside the Conditional  block. The Loop blocks are used to repeat an action. The forever 
programming block represents an infinite loop.

	 2.	 Sensing block contains the programming blocks that enables to read the instructions given 
from input devices.

		  Some of the sensing blocks commands are:
•	 Ask () and Wait: This command ask desired question to which an answer is required.
•	 Reset Timer: This command reset the timer back to 0.
•	 Turn Video (): This command turned the video on.
•	 	Set Video Transparency to ()%: This command set the transparency of the video to desired 

percent.	
	 3.	 In Scratch, the Pen commands make the sprites act as if it were writing instrument. The Pen 

colour, shade and size can be changed. To apply the pen programming blocks:
•	 	Click on ‘Pen’ block in the blocks menu.
•	 	Drag the programming blocks from the ‘Block palette’ and keep it in the ‘Script Area’.
•	 	Set the values as per requirement.

		  Following are the commands that are found under the Pen block: 
•	 Pen Down: This block draws a line on the stage, in the direction in which the Sprite moves. 
•	 Set Pen Size: This block helps set the thickness of the pen. 
•	 Change Pen Color: This block changes the color of the pen.

		  To delete a script or programming block:
•	 	Click and drag the script or programming block to be deleted from the ‘Script Area’.
•	 	Place it back to the ‘Blocks Palette’.

		  The selected script or programming block will be deleted.
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	 To undelete or retrieve back the script or programming block: 
	 • 	 Click on ‘Undelete’ option from the ‘Edit’ menu. 
	 The last deleted script or programming block will be attached back to the mouse pointer. 
	 • 	 Position it on the script area wherever it is required.
B.	 1.	 Conditional blocks are if-else blocks. They check the correctness of the condition as per the 

value given by the user. If the value is ‘true’, then it will execute the blocks that are snapped 
within, otherwise it will execute the blocks that are kept outside the Conditional  block. The 
Loop blocks are used to repeat an action. The forever programming block represents an 
infinite loop.

	 2.	 Sensing block contains the programming blocks that enables to read the instructions given 
from input devices. Let us consider the following programming blocks to see the effect of 
sensing programming blocks.
•	 Insert two sprites from the new sprite buttons; say Lion as ‘Sprite 2’ and Monkey as 

‘Sprite 3’. 
•	 Click on ‘Sprite 2’ in the sprite list and keep the programming blocks as given in the image.

•	 	Click on ‘Sprite 3’ in the sprite list and keep the programming blocks as given below.

when clicked

forever

wait secs

say forI am a monkey

2.25

•	 Click the ‘Green’ flag.
		 When ‘a’ key is pressed, the two sprites will interact with each other.
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	 3.	 Looks blocks contains the programming blocks that control the look of a sprite and display 
graphical effects. Let us see the effects of ‘Looks’ block in the given example.

when clicked

forever

say

change

for

effected by

Hello!

whirl 25

secs2

		  The programming blocks of Looks block (displayed in magenta colour) will change the look 
of the sprite by changing its colour each time the loop is executed and the sprite will display 
a message ‘Hello!’.

	 4.	 XY Plane is a standard two-dimensional coordinate plane that can be used to identify 
the given position of an object. A coordinate system in a two-dimensional plane has two 
perpendicular axes or lines (the x-axis and y-axis).

	 	 The x-axis is the horizontal line on the coordinate plane. It enables LEFT-RIGHT movement.
		  The y-axis is the vertical line on the coordinate plane. It enables UP-DOWN movement.
		  The point on the plane represent the distance from perpendicular lines that intersect at a 

position known as ‘Origin’. The complete plane area on which a point is determined by both 
X and Y positions is called XY Plane. The position in the XY plane is depicted as (x, y). In a 
screen, the ‘X’ position can range from 240 to –240. Here, 240 is the rightmost position of 
the sprite; whereas –240 is the leftmost position. ‘Y’ position can range from 180 to –180. 
180 is the highest point and –180 is the lowest point. 

	 5.	 There are six types of programming blocks in different shapes and each of them helps the 
user to define steps of animation related to the selected button. It also provides an interface 
to input the value of movement or looks of sprite in a project. 

Block Name Shape Function

Hat Block Rounded top and
bumped bottom

This block enables to begin every script. It is shaped 
in such a way that we can place blocks below it.

Stack Block Notch at the top 
and bumped bottom

This block enables to place the other blocks above 
and below it.

Boolean Block
Hexagonal shaped

This block is the condition block which has either of 
the two values; ‘True’ or ‘False’, so it helps to take 
a decision.

Block Name Shape Function

Reporter Block
Rounded edges

This block is the value block that can holds numbers 
and strings.

C-Block
C shaped

This block loops the other blocks within it. It is also 
called as Wrap Block. This block is also used to 
repeat an action.

Cap Block
Notch at the top 
and flat bottom

This block stops the functioning script. It is shaped 
in such a way that no other block can be placed 
below it.

C.	 1.	

move steps50

turn degrees25 	 2.	

turn degrees35

move steps–90

Repeat 10

	 3.	 	 4.	

if on  edge, bounce

stamp

move steps10

forever

	 Python� Unit 4: Scratch or Python

Unsolved Exercise
Part A 

A.	 1.	 Interactive Mode, Script Mode	 2.	 F5	 3.	 int
	 4.	 35	 5.	 Valid : orange
				    Invalid : is
B.	 1.	 ii	 2.	 i	 3.	 i
C.	 1.	 IDLE (GUI)	 2.	 Python Shell	 4.	 >>>
	 4.	 underscore ( _ )	 5.	 Lexical elements/Lexical Units	 6.	 String	
	 7.	 print	 8.	 lower	 9.	 Reserve words

10.
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Block Name Shape Function

Reporter Block
Rounded edges

This block is the value block that can holds numbers 
and strings.

C-Block
C shaped

This block loops the other blocks within it. It is also 
called as Wrap Block. This block is also used to 
repeat an action.

Cap Block
Notch at the top 
and flat bottom

This block stops the functioning script. It is shaped 
in such a way that no other block can be placed 
below it.

C.	 1.	

move steps50

turn degrees25 	 2.	

turn degrees35

move steps–90

Repeat 10

	 3.	 	 4.	

if on  edge, bounce

stamp

move steps10

forever

	 Python� Unit 4: Scratch or Python

Unsolved Exercise
Part A 

A.	 1.	 Interactive Mode, Script Mode	 2.	 F5	 3.	 int
	 4.	 35	 5.	 Valid : orange
				    Invalid : is
B.	 1.	 ii	 2.	 i	 3.	 i
C.	 1.	 IDLE (GUI)	 2.	 Python Shell	 4.	 >>>
	 4.	 underscore ( _ )	 5.	 Lexical elements/Lexical Units	 6.	 String	
	 7.	 print	 8.	 lower	 9.	 Reserve words

10.
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Part B
A.	 1.	 i.	 General Public License	 ii.	 Centrum Wiskunde & Informatica
		  iii.	 Integrated Development Environment	 iv	 Microsoft Installer
	 2.	 i.	 Keyword: Keywords are the reserved words that have a specific function in a program. 

These words are used while writing program to get the desired output. The keywords 
are executed as per their purpose/action defined in the language (interpreter).

		  ii.	 Tokens: The smallest individual unit in a program is referred to as a ‘Token’. Tokens are 
also known as Lexical Elements or Lexical Units. They can be categorised as: identifiers, 
keywords, literals, punctuators and operators.

		  iii.	 Punctuators: Punctuators are used as marks or as separators in a program. The characters 
used as punctuators are ‘ “ # \ ( ) [ ] { } @ , : . ` = ;

		  iv.	 Variable: Variables are the data or values which can change during the execution of a 
program. It is a name given to a location in memory in which the value is stored during 
the execution of a program.

		  v.	 Expression: An expression represents a combination of variables, values and operators, 
which when evaluated produces result in the form of value.

			   Example : sum= a+10
		  vi.	 Operator: Operators are tokens that does computation (calculation) with designated or 

given values in an expression. Operators when applied on operands form an expression.
	 	 vii.	 Python Shell: IDLE (GUI) is the standard ‘Python Development Environment’, to write 

the codes. IDLE is an acronym of Integrated Development Environment. The interactive 
interpreter of Python is called ‘Python Shell’. It creates, debugs, runs and edits Python 
Programs from a single interface.

B.	 1.	 Features of Python Programming Language:
•	 	The keywords of Python are in simple English, hence it is easy to learn.
•	 	Python library is portable and compatible with all types of Operating System hence, it is 

known as platform independent programming language.
•	 	Python is an interpreted language i.e. Python interprets and executes the code, line by 

line. This also makes program of Python, easy to debug.
•	 	It can be easily integrated with C, C++, Java, etc.
•	 	It is case sensitive, which means PRINT and print are two different words for Python.
•	 	It is free to use.	

	 2.	 Data types are the kind of data that is to be stored in the variables which is being used while 
writing a program. 

		  Python imagines the data type of a variable during the execution of program by their syntax.
		  In Python, there are five standard data types:
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	 •	 numbers	 •	 string	 •	 list
	 •	 tuple 	 •	 dictionary
	 3.	 For Single Line Comment: Comment line always starts with the symbol #. 
		  Example : #My First Program
		��  For Multiple Lines Comment: Comment should be enclosed between pair of triple apostrophe 

‘‘‘ ’’’.
		  Example	:	 ‘‘‘My
					     First
					     Program’’’
	 4. 	 Character set in Python consists of valid characters such as alphabets, digits or special 

characters that are recognized by the library of Python Language. 
		  Alphabets 		  A–Z or a–z 
		  Digits 		  0,1,2,3,4,5,6,7,8,9 
		  Special Characters 	 ~ ! @ # % ^ & * ( ) _ - + = | \{}[ ]: ; “ ‘ <> , . ? / , <<, >> 
		  White Spaces 		  Blank space, Horizontal tab, New line, etc.
	 5.	 Guidelines for Creating Identifiers in Python:

•	 	An identifier is an arbitrary sequence of letters in lower case (a to z) & upper case (A to Z), 
digits (0 to 9) and underscore ( _ ).

•	 	The first character of the identifier must be a letter (a to z or A to Z) or an underscore  
( _ ). It must not begin with digits (0–9).

•	 	An identifier must not be a ‘Keyword’.
•	 	An identifier must not contain any special character except underscore ( _ ).

	 6.	 Interactive Mode: ‘Interactive Mode’ allows us to type a set of commands only in a line at 
the command prompt ‘>>>’. Python interprets the given command and gives the output 
when the ‘Enter’ key is pressed for that line.

		  Script Mode: In script mode, we type the set of codes in more than one line in a file and 
then use the interpreter to execute the complete program from the file.

		  Working in interactive mode is convenient for beginners and for testing small modules of 
code, as we can test them immediately for each line while in script mode, we can code a 
program with more number of lines and can also save, edit and reuse the code in future.

	 7.	 Python, in interactive mode, is good enough to learn, experiment or explore, but the only 
drawback is that we cannot save the statements for further use and we have to retype all 
the statements to re-run them.

	 8. 	 It is that portion of the program in which instructions are written to create a program and 
execute it. 
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		  In Python, there are various keyword or statements that helps to execute some task, for 
example; print statement is used to display the output. 

		  Syntax : print ‘message’; [Or] print variable_name 
	 	 Example : print (‘Welcome to ORANGE EDUCATION’) 
	 	 Output : Welcome to ORANGE EDUCATION
	 9.	 Python is being used in many diverse fields such as in Robotics, Scientific Purposes (Used 

by NASA), Search Engines (Google), YouTube, Hardware Testing (Being used by Intel, Cisco, 
HP, etc.), Peer to Peer file sharing (Bit Torrent), GUI Interface (Popularly used in GIMP), 3D 
Animation (Maya, etc.)

C.	 1.	 i.	 Errors is: The variable ‘sum’ should not be in single quotes 
			   Correct statement is: print (sum)
		  (ii) 	Errors is: First statement should be inside print(‘ ‘)
			   In second statement Print should be in lowercase 
			   Correct:  print(‘Your School Name’) 
				                 print (‘ABC Model School’)
	 2.	 i.	 Output:			   ii.	 Output:
	 	 	 Grow Gratitude		 	 6	 	 3
			   4				    Keep
			   729				      Smiling
			   0				    rose rose rose
							       4       16




